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Version 17.99 Update User Guide

This update to the Windows version of the RFMS Business Management System includes many new
features and enhancements. The update also includes many "behind the scenes" changes that
increase processing speed and other performance related functions. This document explains only the
new features contained in this update. For all changes see the release notes on the download web

. ] | = Release Notes»
page. Click the release notes button to find these. | B View bocumen

To see what you may have missed in previous updates click here.
For directions on loading updates to the RFMS software, click here.

The same documentation is included in the online help system and can be accessed by pressing the F1
button at any RFMS screen. If there is something on the screen that you either don't recognize or
understand, check this document or refer to the Help Files pressing F1.

Documentation Conventions

% Notes: Indicates extra Information

o This symbol indicates a best practice or an example.

Indicates Menu item shortcuts: An underlined letter indicates this is a “hot
Setup>System Setup key”. On Main menus click the Alt button plus that key to go directly to that
field or function. On Drop Down menus just type that key.

Field Name Indicates a Field Name or button Name

Important Important information

To conserve space the screen shots are seldom actual size and may have

Screen Shots - .
blank spaces or other non-essential information cropped from them.

A 1 Links to other documents or web pages are included when additional
explanations are available. Click the notebook to find that information.

Various places in this document have links to other topics in the document.
Links to other topics To return to the original topic click Alt + left arrow. Try it out with the link
to the left!

RFMS has many fields that can be user defined. In the documentation,

these will be shown in all capitals with the abbreviation UD before the field
User Defined FIELD UD JOB # |

1ID HEADER LABEL 1 |
LU0 HEADER LABEL 2 |

name.

Update documents contain only the new features contained the software
updates. For all changes see the release notes on the download web page.

| = Release Notes)
Click the release notes button to find these. #8' View Document

Update Release Notes
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https://rfmsinc.zendesk.com/hc/en-us/articles/201559487-RFMS-Program-Update-Instruction-Document
https://rfmsinc.zendesk.com/hc/en-us/sections/200359858-Release-Notes
https://rfmsinc.zendesk.com/hc/en-us/sections/200367553-Update-Documents
http://www.rfms.com/RevisionHistory.aspx

RFMS Button and Menu Conventions

Exit the current screen. Can also use the Escape key on the keyboard.

Access the help file. Can also use the F1 Key on the keyboard.

Activates or selects the highlighted record.

Add a new record. Can also use the Insert key on the keyboard.

Make changes to a record.

Delete a record.

Add or View Notes on a record.

View all notes and Client Management Remarks related to a record.

Find a record using specific fields. Changes to blue when a find is in process.

Resets a filter to the default settings.

Refresh the browse without resetting the filters

i*#ﬁ@ﬁ‘m@ﬁédﬁ{uaT

Saves the current information and exits the screen.

X Cancel Exits the screen without saving the newly entered information.
=] Exact match required in a search.
[ Partial match only required in a search.
Text search
. ctrls Reminder: this searches the browse list from the highlighted record down only.
or Ctrl-

When beginning a search, it is best to begin at the top of the list.

g

Print a document or go to a report menu.

S

Allows adding, changing or deleting the graphic, non-graphic files or web sites.

DR AR

Tag Untag Tagall or Un-tagall record(s). Selects records

Q

View details of a record.

Version 17.99




A

Send an email or RFMS mail message regarding the highlighted record.

View the history of a record.

or View the pdf history of reports for the highlighted record.
Click to view the tracking record created for every record insert made into Orders,
or

Quotes, and Bid Pro Estimates. If gray, no records are present.

Brings up the Client Management remote actions screen and allows adding a
CMM action or relate a CMM record to this record. Yellow indicates that CMM
information is associated with the highlighted record

B
(]

With all date fields in RFMS, hit the D key to fill in today’s date, type in a date, use
the up and down arrows to move the date one day at a time or click F8 to bring up
the calendar and then choose the date.

Window
Cascade
Arrange lcons

1 Customer Orders
2 Customer Quotes
v 3 Browse the Customer File

The bottom part of the screen lists all windows open in the current module. The
one currently being viewed is checked. To view a different window, click it with
the mouse.

£,

Access to customizing the tool bar

Invoice Mumber IEG‘I 02596 )

Disabled Field. If set in >Utilities>System Options>System Wide>General > (Set Up
Global Interface System Options or Override Global Interface System Options)

Required Field. If set in >Utilities>System Options>System Wide>General > (Set Up
Global Interface System Options or Override Global Interface System Options)

Edit Menu

The Edit Menu can be used as a shortcut to the toolbar options.

?gdit>
E (

E Customer Orders

, @7 70D Q0ARE

—

PETH Reports  Utilities  Win

Inzert
Change
Void

‘A
m Overages

Billing Group 4

Change Orders

d

B Payment

ey
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If 16.99 was the last update installed, please check Update Documents for changes made in Versions
17.0and 17.1.

Payroll Update

This version includes the Payroll Update for 2018.
This includes any Federal Tax changes for US and Canada.

The following areas had tax table changes and form changes.

United States

California New Mexico
Colorado* (17.99.6) New York City
District of Columbia New York
Idaho (17.99.8) North Carolina
Kentucky North Dakota (17.99.4)
Louisiana (17.99.3) Oklahoma
Maine Rhode Island
Maryland South Carolina
Minnesota Yonkers
Mississippi Wisconsin
Missouri Utah (17.99.7)
Canada

Alberta Nova Scotia
British Columbia Nunavut
Manitoba Ontario

New Brunswick Saskatchewan
Newfoundland and Labrador Yukon

Northwest Territories

*The Colorado Department of Revenue recommends using these updated tables for the remainder of
calendar year 2018 to ensure more appropriate withholding.

W2 and 1099 Electronic Filling have been added for the following states (Version 17.99.2)

Alabama North Carolina
Colorado Mississippi
Georgia Oklahoma
lllinois Wisconsin
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https://rfmsinc.zendesk.com/hc/en-us/articles/115012819068

For End of the Year documents, click here.

The New Zealand Payroll Update was included in 17.99.6.

System Wide

Navigator (17.99.1)

Business Insights
Business Insights has been added to the RFMS Navigator. For more information on it, click here.

Order Entry

Customer Orders
Billing Groups (17.99.3)

The “No Retainage” checkbox is now sticky on the Change Order screen.

= (o[ =]
i il S E Ly = 1
2 v R o REBBe B e(A)BREBRE S~ uwe Q% D 8O
PEroject Information Projected Costs & Profit
Primary Order No | 5T000023 Project Number | PROJECT £703 J BT 000 Material Cost: 3486
i ) . =
Project Information | BILLING GROUP FOR INVOICE 5T000023 J | | Change Orders: 0.00 Service Cost: 0.00
——————————  Overhead Margin: 0.00
Contract Partial Billing Refainage Grand Total: $0.00 Freight Cost: 0.00
= (i = T Al oo Payments(L:s‘sFC): 000 Load: 0.00
314
Contract Amount |: 2\ Update Change Order Request == 0
Date To Contract |: — 0.00
ails
Change Order Status () Requested O Approved @ NA 0.00%
Allow Einance Charg et Sale)
Description | J |
Orders Contact Informa Request#l ’I ‘
Requested B;
Order Number Custon 5 yl I ‘
Requested Approval Date s F8
Sto
N “
l REquEstREcewedEyl I
Change Order Record Information
A "
Date Created [ 02/20/18 | [1:23pm |
Date Approved =] P8
W Created By |SABR\NA |
Approved By
Date Edited [ 02/20/18 | [1:23em | .
Edited By [ SABRINA | p12.50
$0.00
p12.50
ads Change Order X Gancel B12.50
‘ TrEnvErET
I Close Date l:l
Number of Invoices: 3 [ AO/CM Exists [] Overage Exists [ Change Order [ No Retainage
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https://rfmsinc.zendesk.com/hc/en-us/sections/203600528-Year-End
https://rfmsinc.zendesk.com/hc/en-us/sections/115001898608-Business-Insights-Analytics-Benchmark-Reporting

Job Costing

When "Combine Miscellaneous Cost with Gross Cost" is turned on the Job Cost Sheets will only print
one cost field. It will contain all Material, Service, Loads and Freight numbers.

Page 1 JOB COST Store: 086

Order Entry
Sold To ||ShipTU || Order
PARTLOW, NEIL PARTLOW, NEIL CGTVOIOBZ
120517 TESTING AVENUE 120517 TESTING AVENUE
HELENA, AL 35080 HELENA, AL 35080
Cell Phone: 205-555-1212
Sales Representative #1. CPRIDDY
Prod Inventory Unit Tax Unit Ling Profit
Code Number Quantity Cost Cost Price Total Profit Percent
*Line # 1 Style: MELISSA I Color: CHAMBORD
o7 EBRGTOD 8r8.25 22178 0.00 500 414525 2,307.30 B5 B5%
Base Commission Projected Projected
COMMISSIONS Percent Percentage  Commission Base Commission
CPRIDDY 55.65% 30.00% 2,307.31 69219
GRAND TOTALS
Total Transaction: 4,560.88 Gross Profit: 2,307.31
Net Sale: 4.146.25 Gross Profit Percent: 55.65%
Total Cost: 1,836.94 (Gross Profit / Net Sale)
Tax Cost: 41463 Projected Net Profit: 161512

Projected Net Profit Percent: 38.95%
(Met Profit / Net Sale)

Date Generated: 12/18M7
Time Generated:  2:48PM
Delivered Date: 121817

Quotes (17.99.3)

The ability to sort by Quote Date, Export Date, and Est Del Date has been added.

cr v REcBES T oD QM= DR
Search [ MENT | @ RFMS Smart Search O Estimate Number (O Customer Name O Telephone 1
I
Store Quote # | Export Date [Export Status Quote Type Primary  Customer Name PO Number  JOBInfo Tele #1[<] Work Ship-To Name Ship-To Address #1  CustomerTypg Quote Date EstDel Date Quote Total Sequence ~ Sn
ES900240 | 03/06/0% (Original Expo| Original SKINNER, CATHY |HARDWQOD Rl SKINMER, CATHY 4808 LEEWARD AVE | INSURANCE CIJAI 02/03/09| 03/09/09| 6,033.99| 12,382 b
ES900241 QOriginal SKINNER, CATHY | CARPET REPLAC| SKINNER, CATHY 4308 LEEWARD AVE | INSURANCE CIJAI 02/03/09| 02,/20/09| 4,179.48| 12,583 I
© " | ES900452 Original MORROW COMST| ADDITIONS/REN MOUNDVI MOUNDVILLE Ef COMMERCIAL| 02/27/09| 12/25/09| |22,917.00) 12,794 i
ES901814 Qriginal CLEMENTS, TRACY| CLEMENTS, TRAS CASH & CARR] 08/06/09| 08/06/09| 557.24] 14,156
© | ES00008§ Original A & D HOME IMP| REMODELING 01/18/10| 60.72| 15,251 r
[ ESB006! LM,IM riginal Expol Original STATE FARM \NSLL 0170137’;?45 CTR-2210 205129517205'20 CTR \NVESNEEEWD 17TH AV | \NSURANCEE&JE'M'DS 0341140:5‘_ 4,096.46 _ 2,4‘57
o . . B e el — - I

Products

Rolls (17.99.5)

Grams are now the default roll shipping UOM for weight used for Australia and New Zealand.
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Inventory

Batch Allocator (17.99.6)
Batch Allocator

The Batch Allocator (Dyelot Version) now considers the inventory age first, then the amount left.

Accounting

Accounts Payable
The Supplier has been added to the Payables by Supplier CSV.

| A B c D E F G H I ] K L M
1 |InvNum InvDate TransDate DueDate Invoicefn Discount¥ Discountd MonDischA AmountDi Status Supplier
2 |092817-05 20170928 20170928 20171028 85569.32 0.00% 0 85569.32 85569.32 Flagged ALABAMA RISCORP NATIOMNAL
3 |092817-05 20170928 20170928 20171028 95759.28 0.00% 0 95759.28 95759.28 Flagged ALABAMA RISCORP NATIONAL
4 100217 20171002 20171002 20171101 156.8 0.00% 0 156.8 156.8 Open ALABAMA RISCORP NATIONAL
5 101617 20171016 20171016 20171115 156.8 0.00% 1] 156.8 156.8 Open ALABAMA RISCORP NATIONAL

General Ledger
Importing Journal Entries using a CSV (17.99.3)

File>General Ledger>View Journal>Import

Journal Import will now fail if the import file has multiple periods represented in the data. The
Month/Year must match for all entries or an error will happen.

Human Resources
941 (17.99.5)

The 941 for 2018 has been added to the software.

Prepare Pay (17.99.3)

The ability to click on Sick Hours, Vacation Days, Holiday Days, or Other Leave and enter the number of
hours/days has been added.

If the desired hours/days is accepted, then the Remaining Number of Hours/days will turn blue. If the
amount desired drops below zero, the Remaining Number of xxx hours/days will turn red.
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7 a |
= RFMS Pay Preparation for February 21, 2018 @
Worker AARON, CEDRIC [w-2) leekly _
Prepare Pay Prepared: 0 Dept: GEMNERAL DEPARTMENT Period Ending:
Earnings Amount Store Account 5Sub State E arnings Amount Store Account Sub State
|3R0sS aMoUNT | [P/ | 100000 | (£ [ | [Fel (456 Fe [ |lLa[v] | | IFal| (e[ ] [Fe [ ]Fsl [ ][ [v]
| 78| |E1[] -E-D- | | [F JE[] -D-EI-
(I ] IFa) 455 (Fel [ ][Le e[| ke [ [lFel[|[La
el ] dre [ JlFa [ (e[| rre [ [IFal[_][wa
I |8l | |E1[] I:IID- I | Fal| e[ ] I:IIEI-
Total Earnings 1.000.00 State Tarable Desc EEal -
Federsl 100000 1.000.00 Tax Table - LOUISIaNA - MARRIE BELESa LTS ] 200 | _Holiday Days | 5.00
oo, 18.00 | Other Leave 3.00
FICA 1.000.00
Deductions Amount Store Account Sub Deg \ _
Sick Hours
I |8l | | (1 [] (e8I [ JFel [ ] ]
| |[Fal| | [ |:| |:| [l [ Mumber of Hours Desired 3.00) E
| Fa | |t el [ lFel [ ] ]
Remaining Mumber of Sick Hours: 0.00
I |8l |tRI[] FeI[_JlFsl [ ] L]
| L m [ m e O o |[kcmd |
I Home 4 Freviouz |» et | | M End | | 2 Undo | B Fay | F'[eliminar_l,l @]Erint

If the terms are in red, then the employee has gone over their allotted time. If the terms are blue, then
the employee will have time left after taking these hours/days.

j RFMS Pay Preparation for February 21, 2018 E

Worker | A4R0N, CEDRIC [w-2) eakly | Saolaried+Commission |
Prepare Pay Prepared: O Dept: GEMNERAL DEPARTMENT Period Ending:
Earnings Amount Store Account Sub State E arnings Amount Store Account Sub State
[3A05S AMOUNT | [P/ [ 100000 | (€7 [ | [Fel[4ssFe [ |[La[v] | iz |re[_] (el [_JiFel [ J[alvl
| | IF8l | |1 ] rFel[4ms) e [ [ le] |IF8l| ] e[ JFs[ el
el -E-Duw IIZIIDIEILM
el ] Fe [ Jirel [ ][Le el | ke [ Jlrel [ [[a
I | IF | |E ] IDID- Fl [l ] IDIEI-
T T
TotalEamings | 1.000.00 State Tasable Desc Tg“_ekﬂ: 500 | [ Hiokdan G i
Federal 1.000,00 : 1.000.00 Tax Table - LOUISIANA - MARRIE [ w - oliday Lays :
e MacalnDays| 1500 500
FICa, 1.000.00
Total State | 1.000.00
Deductions Amount Store Account Sub Deductions Amount Store Account Sub
| | IF8l | | B[] tesl e [ | |IFgl| |1[] Fel [ (]
| | IFl | | R[] rel [ JiFsl [ | | IF8l| |RI[] k8l [l ]
I |8l | | R[] Fsl [ Fe ] I | 8| |BI[] [Fel [ ]fFel [ ]
[ |IFal | |RI[ ] Fsl [ e[ ] I | 8| |RI[ ] [Fel [ el [ ]
| | IFal | B[] tesl [ iFm [ | |[Fgl| |1[] (el [ ]
I Home A Previous |» Mext | | »l End | | 3 Undao | Il Pay | F'[eliminary @Erint

Version 17.99

10



Q‘-" HNoles:

Fay

The Time Off will not be posted until the payroll clerk presses the Pay button ‘ and the
payroll is processed. Once processed, the numbers all return to zero. If the pay is not process, the
numbers will remain until the next payroll.

Schedule Pro

Browses

The Copy Browse feature has been added to Job Header and Job Detail browses.

Client Management

Browses

Added List Search (Ctrl+S) feature to the browses for Letters, Contacts and Workflow Actions.

Direct Deposit

Subcontractor

The Subcontractor setup menu option in Direct Deposit has been opened for New Zealand.
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https://rfmsinc.zendesk.com/hc/en-us/articles/202628176-Copying-Browse-Information
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